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Foreward 
 

This manual is prepared for On the Job Training (OJT) for FSD staff how to use GIS for forest management 

planning purpose. Therefore, the manual is not covered full functions of Esri Arc Map and Arc Catalog. The 

explanations are concentrated functions needed for vegetation or forest type map making.  

 

In generally, to obtain digitized topographic map that is defined coordination system (longitude and Latitude) is 

quite difficult in Ghana now. And to make these map by mapping company needed high price burden. This manual 

is introducing a simple and practical way for getting digitizing base map using Land Sat TM (satellite). The 

picture of Land Sat TM that was shot on several years ago is provided by Maryland University (USA) on Internet 

free of charges. 

 

For the vegetation analysis the manual proposed to use picture by Aster (name of Satellite 10m x 10m pic-cell). 

 

The manual explained step by step basis from base digital map making, to make vector maps(digitized map) from 

existed maps printed on papers, how to make new layers for different polygons stored, how to give identifying 

cords to data tables, etc.. And finally to print out a forest management plan maps that shows harvesting plan, 

planting plan, community involvement plan, etc. 

 

The OJT participants are requested to get GIS operational knowledge and experiences through practices how to 

operate the GIS software (Arc View : Esri) using own personal computer. To obtain the skills, OJT participants are 

requested to face difficulties, to make miss operations, then it is most important to consider why the computer was 

not worked that the OJT participant had expected and find solutions by themselves.  

 

This manual is expecting to help the OJT participants for understanding the demonstrated operation within the 

OJT by Mr. Miyazaki. 

 

The author believes, that the OJT participants can find some kind of solutions when he or she made miss operation 

to review this manual and develop their capability if the participant can bear patient works for delineating 

vegetation type demarcation, and its bags clearing, miss conducted features amendment and as well as field 

observation and verification with strong motivation for the development of the Ghanaian forest management 

planning measures. 

 

 

June 2007 

Author Mr. Nobumitsu Miyazaki 

      JICA Expert for PAFORM 
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Section 1  Flow of the works 
 

(1) Outline of the works for making vegetation map using GIS 

 

The procedure of the work is following 

 

1) Base map preparation 

 

a. Download Satellite TM data from Internet for the target are, and decompress the data to Gio- Tiff format. 

=.>  =>   
 

b. Put the Gio-tiff satellite imagery to Arc map 

c. Trace the river line and other typical landmarks as digital shape and make digital base map. 

   

 

2) Add needed topographic information from 1/50,000 paper map to Arc Map 

 

a. Scan a topographic map surrounded the target area for Luster data, and put the data to Arc map  

b. Arrange the topographic map just fit on the base map made above c. 
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 (Red line shows road and blue line shows river on the 

digital base map, Nsemere area had traced from 

1/50,000 topographic map to GIS map as a new layer 

named “Admi area Nsemere”) 

 

Also traced villages location in dark green point mark, 

contour lines on dark orange color. 

 

 

 

f. Trace adjusted topography map needed information such as location of villages, un identified roads from the 

Satellite TM, land marks (such as mining site, factory, etc,) on new layer shape file on the Arc Map. 

 

g. Trace boundary line/shape on the adjusted topographic map to a new layer as “XX area forest reserve”. 

  
   Trace topographic map for digitalizing the map information for new layer shape files. 

 

3) Set a compartment system based on Longitude and Latitude for smooth identification the boundary lines of a 

compartment on the ground. (10 seconds square unit as a parcel for plantation activity management in the field. 

 

a. Establish FSD exiting compartment system on Arc Map. 
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b. Make lines for 10 seconds interval both Longitude and latitude on Arc map. 

 
 

c. Divide the administration area into 10 sec unit tracing Longitude and Latitude line for 10 second units parcel 

map. 

 

 

d. Marge parcels in to compartment. 

 

 

 

 

 

 

 

 

 

 And gives to each polygon for compartment Number. 

 

e. Give a number to each parcel.  
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4) Vegetation/Forest type map making with Satellite Imagery Aster. 

 a.   Aster image covered the target area shall be put on the Arc Map. 

 
b. To adjust the image positions to Base map.  

 

c. Prepare a polygon shape layer for vegetation demarcation named as “Nsemere veget”. 

Copy Nsemere administration polygon to a new layer “Nsemere veget” above. 

 

  

d. Divide Vegetation polygon in to different color patterned areas for temporally vegetation map, and give legenda 

to each vegetation type. 
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 Dividing administration area into similar color patterned area on Aster imagery for delineation of same 

vegetation area for vegetation mapping and give a code for each polygon. 

 

 

Then vegetation map will be made as follows. 
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5) Green Belt area setting (Buffering). 

Green belt shall be set on inside 40m from outer boundary for community participated forest reserve protection. 

 

a. Select “Nsemere administration” polygon, and do buffering command from -40m., a layer excepted 40m area 

(Green Belt area) polygon layer is automatically made (named such as “Nsemere Plantation area”. 

 

 

 

Buffering  

- 40m 

 

 

b. Intersect “Nsemere administration” and “Nsemere Plantation area” using Geo-processing command. Then a 

new layer named “Nsemere GB and PL area” consists Green Belt area, and plantation area polygons on a layer. 

Then give the identifying cord GB and PL for each polygon on data table. 

 Union with  then  

 

6) Every Compartment area shall be divided into Green Belt area and Plantation area. 

 

a. Intersect Compartment layer and Nsemere GB and PL area layer using Geo-processing command. Then a new 

layer shows divided each compartment into Green Belt area and Plantation area. 

 Intersect with   

Then Green Belt area and Plantation area are divided into compartment. 

 

=   
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7) Vegetation map shall be divided into sub-compartment for Forest Inventory Book preparation. 

 

a. Vegetation layer and compartment layer with divided GB shall be intersect using Geo-processing command. 

 And give a number cord to each divided areas for sub-compartment. 

 Intersect  

Then the vegetation map combined with compartment system has made. 
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(2) Preparation of Forest Inventory book and totaling the forest condition of Nsemere Forest reserve. 

 

a. Fill the related data for forest type such as age/planted year, crown density, planted species, etc into every fields 

of the database table. These data shall be prepared by the FSD as stocked records, paper maps, explanations, 

and surveyor’s own field observations and surveys. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Open the Data table of the layer for Vegetation with Green Belt. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fill the fields (columns) Forest type code (F type), Age of the planted forest, Species, and Crown density. 
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b. Export the table in Arc map vegetation and compartment layer as a text file format, and then, read by Excel. 

  Totaling work shall carry using Excel function “Pivot table making”. 

 
  

 Read the exported Text file by Excel (results are following). 

 

0 Comp Sub_C A rea Ha F _Type SPP Age C _dence GBPL A rea m ^2
1 90 5 1 1 .26 NFY O ther 8 70 GB 12630
2 102 5 7 0 .72 M F1 Teak 8 60 GB 7245
3 94 5 3 0 .16 SHR 0 0 GB 1596
4 92 5 2 1 .25 M F1 Teak 8 60 GB 12452
5 98 5 5 0 .30 NFY Teak 8 10 GB 3035
6 96 5 4 1 .24 M F1 Teak 8 70 GB 12395
7 100 5 6 0 .28 NFY Teak 8 10 GB 2795
8 192 9 14 1 .15 GRS 0 0 GB 11494
9 194 9 15 0 .62 SHR 0 0 GB 6200
10 190 9 13 1 .92 SHR 0 0 GB 19177
11 196 9 16 1 .19 NFS O ther 65 20 GB 11876
12 186 9 11 0 .27 SHR 0 0 GB 2684  

 

c. Arrange the excel table to meet general form of the Forest Inventory Book. 

 

F o r e s t  I n v e n t o r y  B o o k  T a i n  1  r e v i s e d  t o  m e e t  G r e e n  B e l t  F e b . 1 0  2 0 0 7  f r o m  A
C o m p  I D F o r e s t C r o w n P l a n t  o r

N o  I D C o m S u b  A r e a  H a T y p e S p e c i e s A g e D e n c i t y G r e e n  b e l t
1 1 1 1 . 5 9 G R S  0 0 G B
2 1 1 0 . 5 3 G R S  0 0 P L
3 1 2 6 . 0 1 M F 2 T e a k 1 7 8 0 G B
4 1 2 1 7 . 0 9 M F 2 T e a k 1 7 8 0 P L
5 1 3 3 . 8 1 G R S  0 0 G B
6 1 3 3 9 . 8 6 G R S  0 0 P L
7 1 4 1 . 6 7 G R S  0 0 G B
8 1 4 3 . 3 2 G R S  0 0 P L
9 1 5 0 . 1 6 M F 1 T e a k 1 2 6 0 G B

1 0 1 5 4 4 . 2 3 M F 1 T e a k 1 2 6 0 P L
1 1 1 6 8 . 0 3 A G R  0 0 P L
1 2 1 7 4 . 8 6 M F 1 T e a k 8 6 5 P L
1 3 1 8 8 . 5 5 S H R  0 0 P L
1 4 1 9 9 . 9 0 G R S  0 0 P L
1 5 1 1 0 1 . 2 0 S H R  0 0 P L
1 6 1 1 1 0 . 9 3 G R S  0 0 G B
1 7 1 1 1 3 0 . 9 2 G R S  0 0 P L
1 8 1 1 2 1 3 . 3 7 S H R  0 0 P L
1 9 1 1 3 5 . 5 7 G R S  0 0 P L
2 0 1 1 4 1 . 8 1 S H R  0 0 G B
2 1 1 1 4 8 . 4 6 S H R  0 0 P L
2 2 1 1 5 3 . 7 8 G R S  0 0 P L
2 3 1 1 6 0 . 8 4 M F 1 T e a k 8 6 0 G B
2 4 1 1 6 0 . 9 2 M F 1 T e a k 8 6 0 P L

C o m p a r m e n t  t o t a l 2 1 7 . 4 1   
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Then you can start forest management planning to fix harvesting areas and periods, needed reforestation areas for 

planting plan, and other factors to insert Arc map such as preservation forest ecological condition for maintaining 

bio-diversity, areas for traditional villagers spiritual forest reserve (except from harvesting targets), etc. 

 

The measures how to operate Arc Map functions are explained from next sections.  
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Section 2  Details of the operation Arc GIS 
 
Sub-Section A Preparation a digital map for GIS base map as defined Longitude , Latitude 

 

1. Download a Satellite TM data from Maryland UNV USA 

 

If you haven’t digital map (vector data/shape files as defined the location by Latitude and Longitude), you have to 

make these Base map by yourself using satellite imagery. A satellite image by land-sat can get in free from 

Maryland University Home page Global Land Cover Facility (Copyright © 1997-2007 University of Maryland) .  

 

(Address of the internet is “http://glcf.umiacs.umd.edu/index.shtml”) 

 

Use Google search “GLCF”, you can find download service page. Follow the instruction on the page. You 

can select a Land sat TM or ETM data where a area you want to analyze. Then you can down load data files 

from Band 01 to 07 in compressed pattern (zip). The down road had finished, you have to defrost the file.  

 

Note: NOAH (name of free use soft for compress and decompress) can use for defrost that you can get 

this soft from internet.) 
Note: Even the compressed file the size is exceeded 30,000 k bites. It means if you cold not use ADSL it 

needs several hours for only 1 picture data. 

The satellite data are not new but effective 

for preparation digital base map for GIS 

 

One example downloads files on Sunyani Ghana 

p194r056_7k20020115_z30_nn62.tif.gz 

p194r056_7t20020115_z30_nn10.tif.gz 

p194r056_7t20020115_z30_nn20.tif.gz 

p194r056_7t20020115_z30_nn30.tif.gz 

p194r056_7t20020115_z30_nn40.tif.gz 

p194r056_7t20020115_z30_nn50.tif.gz 

p194r056_7t20020115_z30_nn70.tif.gz 

Defrost files samples 
A sample TM B&W Band 4 2002.02.10 
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p194r056_7t20020115_z30_nn10.tif 

p194r056_7t20020115_z30_nn20.tif 

p194r056_7t20020115_z30_nn30.tif 

p194r056_7t20020115_z30_nn40.tif 

 

2.  Open GIS (Esri) and view satellite TM (raster data) on arc map GIS (Arc View 9.1) 

 

a. Make a folder “Sunyani GIS 0207Jun (example)”, and store the files Satellite TM (defrosted as Gio-Tif 

format) files on your computer on route directory. 

b. Open Arc Catalog and make link to c:/ Sunyani GIS 0207Jun. 

Then file list will appear on the screen. 

 
 

(i) crick  => select folder Sunyani GIS 0207Jun for establish relation a folder and Arc-catalog. Then 

the catalog view shows right side figure above. 

(ii) crick map icon  for open the arc map. Then a luster file (band 4) on catalog drug and put to map 
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(crick and drug). 

 

When a window for arc map opened you 

give mark to new map if you opened it  

at the first time, and if you had saved the 

map, you can call the map from the 

existed map file list. 

 

If a window like right figure came, 

asking Pyramid Structures building, crick 

yes then computer make the file for 

describing patterns for map view. Then 

map with Land Sat TM image will come 

below (left). 

To expand the map using  

 icon, you can identify rivers lines (right side figure). 

To trace river lines, roads are the bases of the digital base map for analyzing later. 

 

3.  Making river line feature as Poly-line shape file (Layer) for arranging the digital base map 

Why did we use Satellite picture for base map arrangement?, because the satellite data have the location data. The 

picture formatted Gio-Tiff (generally provided from NASA and other sources) can be used Geo-coordination for 

the new map. A paper map can be used, but the fixing location Longitude and Latitude on every corner of the 

paper map have to be cleared. The defining method for GIS arc view needs special knowledge, and not detailed 

explained on the official operating manual. The free satellite data provided by “GLCF” is not new (generally more 

than 5 yeas before captured), but main roads, big rivers are not moved in general. For the digital map fixing 

location making, the data is effective and easy way to use. 

 

(1) Preparation a file for new shape. 

 

Preparation a file for new shape such as 

“river sunyani” and “roadsunyani” using arc 

catalog. 

 Call Arc catalog view => crick File = 

>crick new file => Select shape file  
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Select a file for coordination system definition same as satellite TM (p195r055_7t000202 nn40. tif) among the 

existed coordination defended file list. 

 

 

 

 

 

a. Key in a file name “River 
sunyani”. 

b. Select a type of shape file 
(Polygon, Point, Line). River 
sunyani is “Line” . 

c. Import coordination system 
as below. 
Crick Edit baton in the new 
shape window. 

    New window for 
coordination system 
definition as below left. 

d. Crick import 
  The arc view request to define 
the coordination system same as 
a file existed. You have to select a 
file (The Land Sat satellite file 
that you put to the arc map 
(p195r055_7t20202 40). 
e. Then “OK”. 
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After crick “add” a following window will come. 

Then crick “Apply”. 

 
 

Then crick “Apply” 
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(2) The new file come on the arc catalog, you drag and drop the file to Arc Map. 

 

 

Arc Map                                                      Arc Catalog 

 

A blank shape (line) had set on the Arc Map. 

 

 

(3) Trace the river lines on “Sunyani river” . 

Procedure follows. 

  Star edit => Set Task as “Create New feature” => Set target layer “River sunyani” => Strert tracing the river 

line on the Satellite TM picture  => Save the edit result. 

 

a. Start Editing 

(a) Crick edit and select start edit 

within the pull down menu. 
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(b) Open pull down menu on TASK and select “Create new “Feature” 

 

 

 

 

 

 

 

 

 

 

 

 

b. Set a target layer for editing 

 Open pull down menu on TARGET and select a layer “Sunyani river”  

 

 

 

 

 

 

 

 

 

 

 

 

(c) Trace river lines on the Land Sat TM image like bellow. 

 

To zoom in you can see river lines and 
national roads. Lest figure shows the area 
surrounded Tain1, Yaya and Nsemere. 
Then create new shape file (layer For 
making digital map using road, river and 
typical Landmark such as air strip. 
 

Left side black and white picture is Satellite 

(Landsat TM), you can identify the river 

lines. 
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Follows is traced rivers image.  
Digital map defined the location the same as coordination system Satellite TM You can measure distance on the 

GIS Map. 

 

 

 

(4) Save the drawing for river line. 

 

When you finish the drawing the river, you have to save the edited data and save map data before exit. 

 Edit button => save the edit => end the edit => crick File => save on the same map file => Exit 
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After above process had completed, you can start continuous work after lunch. 

 

(5)  Practice for making road (national road) shape file and show on the arc map. 

 

The procedures are same. 

(a) Make new shape file using arc-catarog. 

(b) Drug and Drop the shape file to arc map. 

(c) Edit (make new feature/ trace road line and junctions as you can identified. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 After traced River and road the digital Base Map above is formulated on Arc Map. 

 

 

 

Small advices 
 
(1) File names is important to identify the meaningful file detect later. During GIS analysis 
especially creating complicated polygons for vegetation, land-use planted areas, harvested 
areas, compartment, etc. etc. and many times of Geo-processing many shape files accumulate in 
your PC/ Folder, You may make many errors, and error files also accumulate in your computer, 
soon you can not manage what file is latest amended one. The file name order is helpful to avoid 
future confusions. 
(2) Error files shall be delete from arc-map as well as arc-catalog when you recognize the file is 
not necessary for your further analysis. 

Small advice: During your editing work, you save the edit occasionally. Computer occasionally freeze as 
your miss operate or un-understandable reasons, then if you did not save the edit, you will loss the edits. 
You have to repeat the same edit again and again. 
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Sub section B  Set up Administration area of a Forest Reserve /Nsemere on Arc Map 
 

For the Use GIS to Forest Reserve Management Planning, match data have to be introduced to the Arc Map such 

as area boundary of the Forest reserve, Compartment system, Management zone, vegetation, Teak Planted records, 

and so on. This section will introduce the procedures to make each layer of above. 

 

1. Introduce Forest Reserve area (Administration boundary) 

 

The forest reserve’s boundary is generally described on the topographic map. The topographic map descried on a 

sheet of paper. The paper material is scanned, and changed into a digital picture. The picture data call as Luster 

data. GIS shape data call as Vector data that have the position(arc data on the Arc Map). This part explains how to 

convert Luster data to Vector data. Vector data has position, length, area data as called “polygon”. 

 

(1) Needed material  

 a. Base map (Sunyani river and road , 2 layers that was made on sub section A 

   Sunyani river. xxx, (Line polygon) 

    Sunyani Road.xxx (Line polygon) 

 

 

 

 

 

 

 

 

 

 

 

 

b. Digitized topographic map 1/50,000 (Scanned 

and jpeg format Luster data) describing the area 

boundary lines on the paper map. 

 

50000 topomap Nsemere.xxx  (Luster Map)  
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(2) Process  

 a. Store the needed files on your folder. 

 b. Run Arc Catalog, and check file list. 

 c. Open Arc map that you are saved for making Base map. Drug and drop. 

 d. Drug and drop “50000 topomap Nsemere” from Arc Catalog to Arc Map. 

 e. If computer ask “Pyramid structure is needed. Do you want?” then answer “Yes”. 

  

 

 

 

 

 

f. On Arc Map left side layer name list you find the name “50000 topomap Nsemere”. 

 

Give  mark to “50000 topomap Nsemer”. Put the cursor on “50000 topomap Nsemere”. And click right button 

of your mouse. Then a menu window 

come. Crick describe all the layer 

command. 

 

Right crick then following menu 

windows will come. Then crick Zoom 

to Layer. 

 

 

The Arc map shows topographic map 

that you scanned. 

 

 

Right figure shows the luster map. But 

the position of the luster map is not 

defined yet, therefore; this map’s 

road and river lines are needed to 

adjusted the location into vector 

data base map using 

“Georeference” function of the Arc 

Map. 

First, you need to harmonize the 

luster map covered area and the 

digital base map covered area. 

Remember the area covered the 

” then answer “Yes” 
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topographic map upper right area, upper left area, lower right and lower left area. Main roads, main river line, and 

main towns covered the topographic map. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Then right crick “Sunyani river” and select fit the layer all command same as above. The Arc map screen will 

change the full area of sunyani river and road. 

 

Remember the cover area for adjusting to vector map “sunyani river” and “sunyani road” 

 

Using  icon, you canarrange the map size zooming in or out. The below map is example to zooming in to 
show Sunyani Town areas, Tain1 and Nsemere. Then the almost same area covered with topographic map shall be 

set on the Arc map window. 
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Some zoom in sample shows bellow map. 

 

 

 

 

 

 

 

 

Following chart is sample for area arranged vector map and luster map. 

 

Next, the luster map shows on the same window of Arc Map River and road polygon layer following procedures. 

 

Crick pull down tag of Geo-reference, and select your target layer name for adjusting to vector map (Sunyani river 

You find the area same as 
topographic map covered 
and zooming in. 
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and road). After set the geo-reference column 

changed to 50000 “topomap nsemere”, crick and 

select “Fit to display” command within the pull 

down menu. Then the Luster map come to the Arc 

map. You can start the detail adjustment.  

 

 

 

The detail adjustment you use  icons. Left icon manage shifting the luster by hand icon and secular 
by secular icon. Middle icon manage setting the connecting points from luster map to vector map. The relation of 

these connection points records are stored connection points table. Use the right icon you can see the table. The 

table can be saved as text file, and you can recall the table for next time adjusting the luster map to vector map. 

 

Fitting measures are 

follows. 

a. First screen on Arc Map 

 

b. Find the clear points on 

Luster Map and Vector 

Map such as junctions, 

river corners.  
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 Expand each points for more accurate adjusting. 

 

 

 

 

 

 

 

 

 

 

 

 

These adjustment points shall be selected four corners parts of the Luster Map. The balance of the adjusting points 

is effect for accuracy of the adjustment. For adjusting points, you use  icon. 
 

After adjusted, the Arc map shows Luster map on the vector map. 

 
  After adjusted +->+ mark shows adjusted points.  

 

The adjusted record is stored on the table. The table you can call by crick the  icon. 

If your adjusting was made error, you call the table and erase the last adjusting points from the table; you can tray 

again to other adjusting points. 
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The table is below. 

 

 

 

 

 

 

 

 

 

 

 

 

Crick save button, and give the file name and folder name where the file shall be saved. 

 

Next times you want make the topographic map on the Base map, you crick load button and select your folder, file 

name, the computer automatically make adjusted picture on the Arc Map again. 

 

(3) Delineate polygon for administration boundary on Arc Map. 

 

Trace the luster map Nsemere boundary line for polygon (convert to the Vector map “admi nsemere”). 

 

a. Prepare new layer file named “admini nsemer” on Arc catalog (process is same as explained for making new 

layer for making base map as “river sunyani” and “road sunyani” (Subsection A, 3, page 16). Import a 

coordination system from “river sunyani”. 

b. Drug and drop the “admi nsemere” to Arc Map. 

c. Start editing. 

d. Create new features. 

  Select “create new features command within the pull down menu. Set the target “admi nsemere” on the target 

column. Then trace the boundary using pencil icon below. For creating or amending features, check the name of 

the targets layer.  
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Commands in the pull down menu for feature making, amending etc. 

 

 

Set the target layer name. Then start delineating, tracings boundary line on Luster map. 

 Then following new shape had made. 

 
 

 

 New feature making 
Change the feature 
   Change the feature shape 
   Cut a polygon 
   Create parallel line feature 
   Cut a line feature/ polygon 
   Amendment a polygon 

admi nsemere 
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(4)  Area calculation  

 

Nsemere forest reserve is 1813 ha officially.  

The area calculation is carry on the data table of a field. You have to make a new field for area on the data table of 

the layer “admi nsemere”. The data table amendment (add fields, calculation area, etc.) is needed to carry under 

the Stop Editing condition. For area calculation a area calculation formula shall be road to the calculation window. 

Process is following:  

 

a. Add a field on the data table of the layer 

End editing =>  

 

b. call the data table. 

Call table (right click the layer name -> Open attribute 

Table. 

 

c. create a field for area on the attribute table. 

 

Crick option button on the attribute table => crick add 

field in the pull down menu then add field window 

came. 

 

Type in The field name “area” => select the field data 

type (Long integer) => type in precision (30) =>OK 

 

 

 

 

 

 

 

 

 

 

 

Set “admi nsemere” 
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Then table automatically change to show the new field for 

“Area”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

d. Area calculation 

Data calculation shall carry under the edit condition. 

Edit => Start Edit => set target “admi nsemere” (Task “create new polygon”) 

Crick Field name by right button => click calculation icon then. 

=> type in field name, type of data, size of column  Crick new field => crick calculator icon  
 

 

 

 

 

 

 

 

 Field calculation window shows bellow will come. 

 

 

 

 

 

 

 

 

 

 

 

Dim pGeo As IGeometry 

Set pGeo = [Shape] 

Dim pPolygon As IPolygon 

Set pPolygon = pGeo 

Dim pArea As IArea 

pArea.Area 
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Load area calculation formula from your folder. 

Area Calculation formula is stored in a  file. 

Then OK. The area is calculated on the data table. 

 

The computer calculated 1970 ha.  

 

The area shows 1970 ha. It means that the boundary line described on the topographic map is not collect. Amend 

the polygon to meet the area same as 1813 ha. This amendment is depends upon the knowledge and information 

about the position of boundary post. 
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2.  Another way to fix boundary line with GPS Data.  

 

In general, the boundary lines described on the 1/50,000 

topographic map of the forest reserves are not so 

accurate. Therefore, you have to conduct land survey for 

boundary post location.  

Carry a GPS and to go to each boundary post for 

reading GPS points (Longitude and Latitude). You mark 

the place to GPS, then make a table like shows on right. 

 

Next, you make point polygons of these boundary post 

position on your Arc Map. Measures are following. 

 

Make a new layer for boundary post (Point Polygon) on 

Arc Catalog => drug and drop the file to Arc Map => 

Change Map Unit from Meter to Degree, Minutes, 

Second Units (Map property) => Start editing (target i 

Layer is “Nsemere Bound Post”) => hold pencil icon and move the cursor to the point observing right down part 

indicator (showing the cursor position by Degree, minutes, second units). If you want fix the cursor just on the 

points, zoom in, it may more easy to find the collect position on the Arc Map. 

 

Next picture shows the example that GPS reading result was trans-planted to the Arc Map. 

 

Right bottom side, Longitude and 

latitude indicator of the cursor (Just put 

on a boundary post arrowed No 2 ) 

 

 

 

 

 

 

 

 

 

Make a polygon connecting with boundary posts “admi nsemere”. 

 

Below is administration area shown by the GPS land survey. 

 

 

Post number D M S D M S
2 N 7 30 39.3 W 2 10  45.9
5 N 7 31 5.9 W 2 12  00.9
6 N 7 31 15 W 2 12  25.8
7 N 7 31 23.8 W 2 12  51.0
8 N 7 31 32.9 W 2 13  16.1
9 N 7 31 46.3 W 2 13  54.0
10 N 7 31 50.7 W 2 14  05.6
11 N 7 32 0 W 2 14  31.8
12 N 7 32 26.2 W 2 14  36.7
13 N 7 32 50.1 W 2 14  41.0
14 N 7 33 15.8 W 2 14  41.9
15 N 7 33 36.6 W 2 14  40.8
18 N 7 33 4.6 W 2 13  27.9
19 N 7 32 53.8 W 2 13  03.6
21 N 7 32 32 W 2 12  15.0
22 N 7 32 21.4 W 2 11  51.0
23 N 7 32 10.6 W 2 11  26.8
24 N 7 31 59.6 W 2 11  02.1
25 N 7 31 43.7 W 2 10  25.3
26 N 7 31 38.1 W 2 10  14.5
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The area had been defined by GPS survey. Total area shows 1927 ha. If the boundary post mined exact place and 

not moved, the area is 1927 ha but 1813 ha. 
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Sub Section C  Set up Compartment system 
  

(1) Make exited compartment using luster map of 

FSD. 

 

Paper map on existing compartment shows right. 

The map is needed to convert to vector data (shape 

file). 

 

a. Scan the FSD compartment map to Luster data 

and store on your folder.  

b. Open Arc Catalog and add the Luster data file on 

the list using “refresh” function. 

 Right crick on the folder calling pull down menu => crick refresh 

Then Arc catalog read new files that you add on your folder. 

 

c. Open Arc map, and renew the Arc map file list and make a new layer for 

“Comp FSD Nsemere”  

  

d. Drug and Drop “Comp FSD Nsemere” to Arc Map.  

 

e. Adjust the location of the Luster map to administration area. 

 Process is same as administration boundary layer making (subsection A 1). 

Give Check mark  =>  Right crick layer 

name => Crick Zoom to Layer 

Then following picture come to the Arc Map window. 
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Adjust the luster compartment map to vector administration polygon using georeferencing function. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    Luster map adjusted to Vector administration layer is as below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

d. Make new empty layer for FSD compartment Nusemere (Polygon). 

  Open Arc Catalog => File => New  => shape => define shape type (Polygon) => Edit special reference 

=>Import => select “sunyani river” => OK => apply. 

Drag and drop the new shape file to Arc Map => give mark active on the lyer list. 
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Start Edit => Set “Creat new polygon on task column => Set Target column “Comp FSD Nsemere” 

Copy administration polygon to “Comp FSD”. 

 

Select a polygon (administration: changed polygon outline into right blue, copy then past on the new layer “Comp 

FSD”.  Set Taks column and Target column on edit bar as above. (“Create New Polygon” on Task, Target on 

“Comp FDS Nsemere”) 

 

Then outer boundary of the forest reserve is made as the part of Compartment layer. The compartment is made by 

dividing the administration area based on (tracing) Luster map adjusted the position (georeference) to the 

administration layer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

e. Divide administration area into compartment. 

Edit => Start editing => Check editing target (“Comp FSD Nsemere”) => Set Task “Cut Polygon Feature” 

 

Divide a polygon into compartments using Pencil tool as below sample. 
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f. Save the divided results on your 

PC. And arrange data table for 

compartment ID (No) and area 

calculation. 

 

Edit=> Save edit=> stop editing => 

open data table = add fields “area” 

Comp FSD ID”, then start editing 

=> calculate area for compartment 

=> give compartment number to each column of the field “Comp FSD ID” => open layer property => give label 

making commands. Then Arc Map shows compartment FSD on the area defined by GPS survey. 

 

(2) Arrange data table for Compartment Number labeling. 

a. Open Data Table( attribute table). 

Right Crick layer file name => select “Open Attribute Table. 

 

Following table will come. 

 

The attribute table shows 

3 columns no of polygon, 

type of polygon, and ID. 

The divided polygon for 

compartment shall be given compartment ID (No), and area. For this data inserting, 2 columns are needed. You 

have to made new two columns on this data table. 

 

 

 

b. Add fields. 

Crick Options button => select New field 

Then field edit window will come.. 

Field 



 40

Give field name: Comp No,  Area 

Decide field type : Shot or long Integer ot Text 

(short integer for compartment No, and Long integer for area) 

Decide width of column (Precision) : 10 for Compartment No, 30 for area example) 

 

If Arc Map is working under editing mode, before new column / field making STOP the EDIT. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

c. Add Compartment No. to the table. 

Edit => Start Edit => select a polygon => crick color changed line of the Compartment field on the data table => 

Type Compartment number that was read from adjusted Luster compartment map => repeat same to all 
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compartment. 

Select a compartment area, then one line of the data table change the color in blue, the line reflects the polygon, so 

type the compartment number to the field of blue column. 

 

d. Insert Area calculated and Compartment ID to each column. 

Polygon data have the information of area. The area calculation is carry on following measures. 

 

Crick area field title column then vertical columns are change color as selected condition => Right crick  icon 

within the pull down menu then calculation formulae window will come. => Road area calculation formula file  

=> Crick OK 

The area calculation formula is stored as a file named “  “. 
 

 

 

 

 

 

 

 

 

 

Calculation formulae window 

 

Then area column filled number of areas in m^2 base. 

 

Dim pGeo As IGeometry 

Set pGeo = [Shape] 

Dim pPolygon As IPolygon 

Set pPolygon = pGeo 

Dim pArea As IArea 

Set pArea = pPolygon 

pArea.Area 



 42

(3)  Make new compartment system based on Longitude and latitude line. 

 

   Procedures are roughly following 4 steps a. to d.  

a) Make a new layer for 10 second longitude and Latitude line polygon on Arc Catalog named “Parcel 

Nsemere GPS” (procedure is same as above Sub section A3 (2) (p19)). 

b) Make a new layer for Latitude and Longitude Line (Polygon) unit parcel on Arc Catalog named “LL line  

Nsemere”. 

c) Divide parcel “Percel Nsemere GPS” in to parcels based on the 10 second longitude and latitude line. 

d). Combine parcels based on the 30” units into Compartments. 

 

a. Methods for making line polygons of Longitude and Latitude by Grid making function. 

 a.1 Change layer describing Unit from meter unit to Degree, minutes, second system using Data Flam property 

General Tag. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

General: map 
delineation unit ( Set as f 
Longitude and Latitude 
(Degree Minutes Second)  
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a.2  Open grid window using grid tag on the same data flame property. 

 

 

 

 

 

 

Then Grid wizard will come as below. Follow the instruction on the window. Mark on top line. , then click 

“Next”. 

 

 Key in unit for Longitude and Latitude (10 second for both); then, next computer asks how to delineate (Size and 

style of line, style of laver) Let try several 

patterns later. Now only crick Next (obey 

the original style). 

 Then new window right picture will 

come. Click the button complete. 

 

Grid system controlling procedures are 

set; the window will change same as 

started, but inserted a line, check mark on 

the line. If you want not describe LL line 

temporally, you erase the check mark on 
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this window. 

 

 

a.3 Change Arc map from Data view to Map View using below center icon left below part of the data View 

window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Layout View sample: 10 second unit grid described map will arise on your computer screen. 

 

a.4  Save this layout view map as a luster data to your folder as proper file name. 

 

Export the map to your Folder under the name “Nsemere 10 sec grid map”, and renew the arc catalog. Then the 

Luster map files to Arc map.  

 

Stop edit => Crick File => 

select Export Map within the 

pull down menu => give the 

file name and store on your 

folder. 

 

Layout View  

Data View 
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(b) Making the 10 second unit line polygon as a new layer. 

 

For the 10 second unit polygon making, you use a copied polygon of “Admi Nsemere” to a new layer “Parcel 

Nsemere” And divided a polygon on the layer “Parcel Nsemere” into 10 second units by tracing the luster map of 

“Nsemere 10 sec grid map”. 

 

Preparation 

a) Make a new layer file on Arc Catalog as named “Parcel Nsemere” ( measuers are same as from (2) a. to d .  

And put it to Arc Map. 

b) Insert Luster map “Nsemere 10 sec grid map” to Arc Map. 

 

Open Arc catalog => renew the file name list in your folder => Drug and Drop the Luster map “Nsemere 10 sec 

grid map” and new layer “Parcel Nsemere” to Arc map. 

 

 

c) Adjust the location of  The Luster map  “Nsemere 10 sec grid map”  to “sunyani road” and “sunyani river” 

(base map of vector map). Measures of this adjusting is same process as mentioned before (See 3.1.e). 
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Following chart is adjusted the location Grid map to Base map. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You finish preparation for making new layer for Longitude and Latitude line polygon. This line polygon and label 

of the line (mark of Latitude and longitude) is effectively used for field verify to seek your standing point reading 

GPS and same point on the map. 

 

(c)  Make new layer file for Longitude and Latitude line polygon trasing LL line above (adjusted LL line luster 

map) 

 

  Open Arc Catalog => new file => give name “Nsemere Grid 10 sec”, line polygon => import coordination 

system (“sunyaniriver”) => Drug and drop the file to Arc Map => start editing => New feature “Nsemere Grid 10 

sec”. 

 

Trace grid map lines and create line polygons for longitude line and latitude line. 

 

(d) Give location data to data field on data table (Data Table management). 

 

=> end the editing => open data table => add fields for Longitude, and Latitude => start editing => type in each 

line degree, minutes, second => save the edit => stop edit => open layer property => set label ( formula as 

Long&”:”& Lati). 

 

Red lines are new feature and labeled on each line for Latitude or Longitude. 
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b. Create new layer on 10 

second union Parcels 

(Polygon). 

 

 Divide administration area 

into 10 second parcel using 

“divide polygon” command 

under the editing command 

list (pull down menu).   

give chack mark at 
“Parcel Nsemere GPS” on 

leftside layer list of Aerc 

Map, then total administration area of Nsemere is 

described on your Arc Map. 

 

Trace Latitude line and Longitude line (red line of the 

below figure like) using pencil icon. 

Edit => start edit => set Task “Cut polygon” => set 

target “Parcel Nsemere GPS” => select a polygon => 

Trace a LL line using pencil icon = = = > repeat select 

a polygon and devide => edit => stop editing => save 

the edit. 

 

The administration area had divided in to 10 second units 

parcels Polygons. 
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c  Marge parcels into compartments. 

 

Compartment polygon is made combining several Parcels above based on the 30 second latitude and 60 second 

longitude. Procedures are as follows. 

 

Make a new layer for compartment on Arc Catalog ( New file => give name (Nsemere 10sec comp GPS) and 

folder => select type (Polygon) => import coordination system (sunyaniriver) = apply the coordination system to 

“Nsemere 10 sec comp GPS” => Drug and drop the file to Arc Map => start edit on the target “Nsemere 10 sec 

comp GPS” => select all polygons of “Nsemere 10 sec parcel GPS” using related data table  => Copy the 

polygons to “Nsemere 10 sec comp GPS” => select polygons on “Nsemere 10 sec comp GPS” to meet 30 second 

unit N-S 60 second unit E-W. => Marge selected polygons into a parcel => repeat same process for all 

compartment areas. 

 

c.1 Use the land mark for compartment boundary first. 

Compartment is also demarcate the area by natural land feature such as clear mountain ridge or river line; 

therefore, combining the parcels above, you need to observe the target area whether the typical land feature are 

recognized or not. If you find river line or ridge line, it is advisable to use these line for compartment boundary. 

if no typical land marks are found, compartment shall be set on Longitude and latitude line. 

 

In Nsemere, a mountain stay in the northern part, and ridge line closing the reserve, therefore, this land mark shall 

be first to set compartment boundary. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Draw counter line used topographic map (luster map). Adjust the luster map to the Base map (vector map) 

location to “Sunyani river” and “Sunyani road” and trace the counter lines to a new layer for “Nsemere counter 

50000”. 
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c.2  Divide 10 sec parcels with ridge line of the mountain/hill. 

 

Start edit (target is “Nsemere 10 sec comp GPS”) => Select parcels surrounding hill ridge line => Cut the parcels 

using pencil icon. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

c.3  Decide compartment boundary setting line on where ( Base degree for Latitude N-S, for Longitude E-W). 

   In this case, start from 7,30,00N 30 second interval for W=E, and from 2,11,00 W 60 second interval is used.
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c.4  Select parcels within the square of area within the 30 second N-S, 60 second W-E units And merge the 

selected parcels to 1 polygon as a compartment using the merge command within the pull down menu of Edit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

c5.  The demarcated compartment is follows; then, parcel No, compartment number shall be given to each 

polygon using data table. 

 

 

 -  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7,33,30 N 

2,14,00 W
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Fields preparation. 

Edit => Stop Editing => Crick layer file name to call the data table => Crick option => add field => Give field 

name “CompID” => select type “short integer” => Give precision “10” => OK  (repeat the process for needed 

fields making such as area (long integer 30),  etc.) . 

 

- giving compartment No    

 

c.5  Arrange Data table. 

   area, compartment No 

   Stop Edit => Open table => Option => Make new fields => field name, type, size => Start edit => type 

compartment No to field ID => calculate area calling the formula file => Save edit => stop edit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right side table shows the result, giving 

compartment name, and calculated area.  
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Figure bellow shows Compartment system and Longitude, Latitude. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Then repeat to each parcel into parcel number. This number reflect as the addles of the each peace of land. 

Every planning works in the Forest Management Plan can defined the location on the map as well as on the 

ground by the name of Compartment and parcel number. Figure below shows this addles system on the Arc Map. 
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Following chart is comparison between existed FSD Compartment and new proposed one. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Check area table. If you find small polygons, it means you conduct something wrong. You have to find 

the small polygon, and merge to suitable compartment polygon. The number of the compartment is 17. Small 

polygons are never existed. Bugs removing measures are explained later chapter. 
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Sub-section D  Preparation for Forest management Unit (Green Belt, Compartment) 
 
How set up the area for Green Belt (40m width belt area from the reserve boundary) = Buffering. 
 

1.  Buffering for 40m width area from the boundary line. 

 

Select “admi nsemere” polygon, and do buffering command from -40m., a layer excepted 40m area (Green Belt 

area) polygon layer is automatically made (named such as “Nsemere Plantation area”. 

 

 

 

 

 

 

 

 

Crick tool box => then tools window come => crick Analysis tool =>Select Buffer => select single buffer (dabble 

crick) then buffering control window will come. 

 

 

 

 

Buffering  

- 40m 

Tool Box Icon 
Tool Box window 
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 a. Select a target polygon (line or polygon file name: “admi nsemere GPS”) and a file name for out put 

(“Nsemere Plantation area”) with saving folder’s name. then “OK”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Then computer make a new layer 

delineated 40 m narrow area (except 

Green Belt area). 

 

 

 

 

 

 

 

 

2.  Delete the 40m inside area from total administration area for green belt area. 

 

Intersect “admi nsemere” and “Nsemere Plantation area” using Geo-processing command. Then a new layer 

named “Nsemere GB and PL area” consist Green Belt area, and plantation area polygons on a layer. Then give 

the identifying cord GB and PL for each polygon on data table. 

 Union with  then  

 

Buffering 
size 
Unit/ meter 

Buffering 
size 
-40 
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The data table unitized Buffer (-40m inside) and “Admi nsemere” area have fields both original fields of respected 

layers, therefore, erise fields unnecessary or duprocate. And add a field for polygon identification for Green belt 

area(GB) and Plantation area (PL). Give the code GB and PL to each column of the polygon. The arranged table is 

shown as above. 

 

Open table => stop edit => add field as “PL GB” (on text 5 letters column size) => start edit => calculate area 

=> give PL or GB on the new field. 
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3. Every Compartment areas shall be divided into Green Belt area and Plantation area. 

 

a. Intersect Compartment layer and Nsemere GB and PL area layer using Geo-processing command. Then a new 

layer shows divided each compartment into Green Belt area and Plantation area. 

 Intersect both as below. 

 

 

 

 

 

 

 

 

 

 

 

 

Then Green Belt area and Plantation area are divided into compartment. Call the attribute table and arrange fields. 
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Calculate areas of every polygons. Then you can get the table shows above.  

 

Procedures are as follows: 

Put the files “Nsemere 10 sec comp GPS” and “Nsemere GB and PL area” on top position of the left side of the 

Arc Map file name list. => call Arc Tool => crick analysis tool  => Crick Overlay => Crick Intersect 

Do not forget the name mentioning for exporting (“Comp GB Nsemere”). 
 
The final out put is following. 

 
The green belt area and plantation areas are divided into compartment system.  
 
You prepared for making vegetation/forest type map and arranging the Forest Inventory book. 
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Section 3 GIS Arc Map for making Vegetation Map 
 

Now we finish the preparation for Management unit compartment polygons on the Arc Map. Next job is the core 

part to analyze latest forest situation. Generally, foresters always grasping his responsible area, recorded every 

compartment, sub-compartment situation such as when it was planted, what species are growing, when it will be 

harvested and replanted. Nevertheless, many countries facing difficulties to do same as ideal because of limited 

man power, limited resources for surveying patrolling. Some case un-planed/illegal logging, wild fire, natural 

disaster give damages forests, and forester can not hold the real situation. Forest area is so large, to observe the 

areas may needed months and years. The satellite data is expected to help foresters field observation in wider area 

in shot time. 

 

This section is introducing the methods how to use satellite imagery for analyzing the expansion of 

forest/vegetation areas and fix the position on map, and calculate areas under the forest management unit such as 

compartment system. 

 

The measures/procedure satellite image arranged for forest management planning are roughly follows. 

a. get latest satellite imagery (In this manual Aster data is used). 

b. Put the aster data on Arc Map (arrange the coordination/position). 

c. Delineate similar patterned areas as polygon. 

d. Field vilify for finding significant meaning the area shows on the satellite imagery. 

e. Define vegetation types reflecting to the typical patterns of the satellite images. 

f. To intersect compartment polygon and vegetation polygon. 

g. Calculate area by compartment/sub-compartment.  

h. Order the calculate result as a Forest Inventory Book (compartment, sub-compartment, vegetation pattern). 

i. Add existed data to Forest Inventory Book such as main tree sepsis, planted year/age, crown density, stand 

number/ha, special plan or animal living, existence of traditional use by the surrounded communities, etc. etc. 

g. To present the forest Inventory Book to the responsible planning units of FSD for Forest Management Plan 

formulation. 

 

This section mainly explain the procedure operating Arc View for a to g above, and h to g will explain on the 

next section. 

 

1. What kind of Satellite data shall be used. 

 
There are many satellites around the grove. Typical are Land Sat, Aster , Spot, etc. etc. The resolution of the 

satellite is deferent. Covering area by a sheet (picture) is deferent. Price is quite deferent.  

 

In this manual, author selected “Aster” because of the price level and vegetation condition of the target area 

(Sunyani district Ghana, not high complex of forest, not complicated land feature).  
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Satellite data consist with several band pictures. Following a figure explains that Band 4 of TM shows much 

reflecting for the amount of the plant (leafs of the plant). 

 

 

 

 

 

 

 

 

 

  
 
 
 
 
 
 
 

 
2. Put satellite image (Luster data) into Arc Map made through previous section 
 
Original data was 

prepared as a Luster data 

file (Processed for 

vegetation analyzing). 

 
 
 
 

Red 1, Green 2, Blue 3 band                               Red 1, Green 4, Blue 3 band                  Red 4, Green 3, Blue1 bandRed 1, Green 2, Blue 3 band                               Red 1, Green 4, Blue 3 band                  Red 4, Green 3, Blue1 band
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The size of Aster picture is too large, therefore, part of above picture covering typical land feature (road, river) 

surrounded the target forest reserve Nsemere as below. Cutting the picture was done using Photoshop (Adobe).   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
a. The above Luster picture shall be adjusted to the base map. 

 

Procedure is same as topographic map to base map explained on sub part A.  

 

Open Aerc Catalog => crick a luster file “070430 Aster Nsemere” => drug to Arc Map => give chek mark to 

files on , “river sunyani”, “road sunyani”, and “admi nsemere” => harmonize the 
described area of Base Map and Aster Nsemere =>set georife070430aster nsemere => crick georigerence tag => 

Fit to display. 

Then adjust aster nsemere 

to Base map using   
icon => open 

georeference Link table 

=> save the table (give a 

file name for example “fix 

point 070430 aster 

nsemere” on the same 

folder that the file “aster 

nsemere” stored. 
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3.  Demarcation for similar patterned areas as a polygon. 

 

First you have to prepare a new layer “Veget Nsemere” for vegetation polygon writing, then copy “admi nsemere” 

for target area fixing to the layer of “Veget Nsemere”. The vegetation map is made dividing the total target area 

(admi nsemere) into vegetation type reflected areas. 

 

Open Arc Catalog =>File => New => Shape file => name of file “Veget Nsemere” => Type “Polygon” => Edit 

coordination => Import (river nsemere) => apply => drag and drop “Veget Nsemere” to Arc Map 

 

On Arc Map mark on file “Veget Nsemere” => Edit => Start Editing => set task Create new polygon => set target 

“Veget Nsemere” => Select a polygon from the layer “admi nsemere” => copy => erase check mark of the file 

“admi nsemere” => Past to the layer “Veget Nsemere”. 

 

Then you finish preparation for delineating the vegetation polygons. 

 

  
 

Find Teak forest reflecting patter, and demarcate area for a polygon 
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Select a polygon => cut the polygon in edit tool => trace the similar area from a point cross the selected polygon 

outline to other point cross of the selected polygon out line. 

 

Samples of typical pattern of satellite Aster images reflecting to the vegetation type 

 

Generally, satellite image is reflecting something on the land surface character; you need to find relation which 

pattern shows what type of forest/vegetation. Before vegetation delineation on Arc Map, you visit real fields and 

observe what kind of vegetation type exist on where, then to compare your knowledge about real fields. 

 

You make some standards how to interpret the satellite image to vegetation type. 

Followings are sample that the author found such relation on the field study on Tain 1 and Nsemere area and Aster 

Satellite image. To apply this process on other area, by other sheet of Aster picture, you have to make these 

standards to meet real field situation and Aster data feature (Color pattern may difference picture by picture 

because of different natural/ sky conditions on the satellite photo shot time). 

 

Forest type ID Typical Pattern Explanation 

Open natural forest 

 

Crown of the top and middle layer  covered less 

than 10%. 

 

Teak forest 1 

 

Age 6-15 reached  to closed condition 

by crowns. 

Dark green and dark red are mixing, partly open 

places are remaining. 

Teak forest 2 

 

Age15-20 reaching to thinning age. 

Satellite images are similar with above, therefore, 

decide from planted records. 

 

Teak forest 3 

 

Age 20 or more, reaching to harvesting age. 
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Forest type ID Typical Pattern Explanation 

Grass land 

 

Grass covered, and  crowns of high tree or shrub 

tree covered. 

River side grass land occasionally flooded. 

Farming land 

 

 

Shrub area 

 

 

 

Then target area divided into vegetation type/Forest type are as follows. 
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Finally, you will got following polygons on the layer “Veget Nsemere”. 

Next job is give a code and other information to each polygon such as vegetation code, age, species, crown density, 

and other factors you needed. These data you can obtain from your Forestry related offices or field survey. 

 

The data is type in on the attribute table of the layer.  

Call attribute table of the layer. 

Right crick on the layer => Open attribute table. 
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To arrange attribute table for making the fields for Forest type (F_Type: text), Area (long integer), Compartment 

(Comp shot integer ), sub-compartment (S_comp short integer ), Age (short integer), Species (spp: text), Crown 

density (C Dence: short integer), Planting area or Green belt area (P_G text). 

 

The field making is carried non editing condition, if the arc map moving under the editing condition, end and save 

existed editing. Then crick Options button on the bottom right side of the attribute table. And select new field 

making. Type in Name of the field width of the column or select, data type (short integer , long integer, or text). 

 

 

Then start edit. Crick start edit edit => set target layer (Nsemere aeget) 

 First calculate area of each line (polygon). Right crick field name “area” => crick calculator icon => load area 

calculation formula => OK 

 

The field area of each polygon will filed automatically number. Sort the area from small to large, if you find area 

“0” or very small, this shows there are many irregular polygons remain. Amend the polygons one by one. The 

works for removing these irregular polygons is one of unwelcome work, nevertheless, it shall be done. Methods 

are shows on chapter 5 of Section 6. 

 

Then, you start filling data to fields of each line based on your field survey or data collected. 

Follows is a example after filled the data. 
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Then give pattern and label for each forest/vegetation type. How to manage legend and label are explained later. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Give labels for every polygon. 

 

 

 

 

Vegetation map was completed. 
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4. The Vegetation map shall be divided into Forest Management Unit (compartment and sub compartment) 

 

The vegetation map shows areas same vegetation category such as teak forest, grass land, etc. For the Forest 

management planning, the vegetation map and compartment system need to link. The forest management tasks 

generally organized based on the compartment system.. The forest area situation data stored Forest Inventory 

Book that recorded  some number of has of Teak forest, grass lands, bush land , farm land, etc. 

 

(1) Vegetation map and compartment map combining by Geo-processing (Intersect). 

 

Call tool box  => Analysis tool => intersect => come a intersect tool window. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Give a file name to input column or select a layer within pull down list (“Veget Nsemere”) => the layer name 

automatically shift to feature column then input next layer in same manner (“Comp GB Nsemere”). => Give a 
name for new layer after intersected to be stored (Comp GB Veget Nsemere”) => OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

Veget Nsemere 

Comp GB Nsemere 

Comp GB Veget Nsemere 



 69

When “Intersect” had completed, Arc Map shows following layer (Comp GB Veget Nsemere). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Vegetation Map had been divided into compartment and Green belt areas& planting areas. 

 

Next you may have to carry bag polygons elimination. Call attribute table, and calculate areas. Give labels for 

every polygon as Forest type, You found many area “0” columns/polygons, and many label letters along with 

visible polygons outline. You have to delete these bag polygons.  
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Zoom in the map, you can find following parts. 

 
 
 
 
 
 
 
 
 
 
 

These was original vegetation polygons were duplicated. 

 

This case was compartment polygons were duplicated. 
 
 
 
 
 
 Attribute table shows many polygons with area “0” 

existing 

 
After removed all bag polygons, you start giving sub-compartment id on every polygon. The numbering order is 

start from upper rite corner and circle for opposite direction of crock moving direction (right to left, upper to 

down). Green belt part is given the same number just adjourned polygon id same forest type.  
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Then you will finish vegetation map showing compartment unit as bellow. 

 

 
 

 
 
 
 
 
 
 

Small advice 
When you try the bag polygons to merge to adjured polygon, you zoom in and find deprecated 
polygons generally 2. You have to merge small polygon “a” and b to “c”. if polygon a is GRS and 
polygon “b” is SHR and “c” is grass, “d” is SHR, you want to merge the 2 small polygon as GRS c, 
you select a and c and merge, and then select a+c and b then merge. The 2 small polygons are 
removed and merged to polygon c. After merged, you need to check the forest type id if merged c 
shows SHR, you have to amend the attribute table as GRS. This occur the small polygons have 
deferent id of Forest type, GRS or SHR result is depend on which small polygon is upper or lower. 
You can not identify before you merged, therefore, some case shows GRS other case SHR. 
The duplicated polygons are many, during this amendment, many polygons change the Codes, 
therefore, you make a copy file on different file name as vegetation original. Then you finish the 
amendment, call the saved original file and compare the 2 layer. If amended polygons shows 
deferent id with original, you have to amend the attribute table. 
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Small advice : 
Amending polygons separated several positions after Intersect (Veget and Comp). 

Compartment polygon

Vegetation polygon  

Some case a polygon divided into several compartments. 

d

c2
b

a2a1

c1

 

Computer divide 4 polygons a, b, c, and d for each block, then Arc map shows 6 parts 2 a1,a2, 
b,  c1, c2 and d. Nevertheless, on attribute table 4 lines polygons only recorded. Arc map 

recognizing a1 and a2 is 1 polygon. You have to amend the polygon into 2 polygons. Measures 
for amending are explained on Section XX. But amending process is troublesome. 

 
For avoiding these amendment, you divide the polygon covered more than 2 parts in a adjured 
compartment in to several parts before Geoprocessing “Intersect” shall be done like below. 

d

c2
b

a2a1

c1

 
After the Intersect done, Arc map recognize 9 polygons, then after you can mage divided parts 
into a polygon within a same compartment.  
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